Trend Micro Incorporated reserves the right to make changes to this document and to the product described herein without notice. Before installing and using the product, review the readme files, release notes, and/or the latest version of the applicable documentation, which are available from the Trend Micro website at:


Trend Micro, the Trend Micro t-ball logo, Trend Micro Apex Central, Trend Micro Apex One, Control Manager, and OfficeScan are trademarks or registered trademarks of Trend Micro Incorporated. All other product or company names may be trademarks or registered trademarks of their owners.

Copyright © 2019. Trend Micro Incorporated. All rights reserved.

Document Part No.: APEM08571/190103

Release Date: March 2019

Protected by U.S. Patent No.: 5,623,600; 5,889,943; 5,951,698; 6,119,165
This documentation introduces the main features of the product and/or provides installation instructions for a production environment. Read through the documentation before installing or using the product.

Detailed information about how to use specific features within the product may be available at the Trend Micro Online Help Center and/or the Trend Micro Knowledge Base.

Trend Micro always seeks to improve its documentation. If you have questions, comments, or suggestions about this or any Trend Micro document, please contact us at docs@trendmicro.com.

Evaluate this documentation on the following site:

http://www.trendmicro.com/download/documentation/rating.asp
# Table of Contents

## Preface

Preface ........................................................................................................................................... v  
Documentation ......................................................................................................................... vi  
Audience ....................................................................................................................................... vii  
Document Conventions .............................................................................................................. vii  
Terminology .................................................................................................................................. viii

## Chapter 1: Introducing Apex Central

About Apex Central ..................................................................................................................... 1-2  
Key Features and Benefits .......................................................................................................... 1-2  
Apex Central Architecture ......................................................................................................... 1-4

## Chapter 2: Installation Planning

Identifying Deployment Architecture and Strategy ................................................................. 2-2  
Understanding Single-Site Deployment .................................................................................. 2-3  
Understanding Multiple-Site Deployment ............................................................................... 2-4  
Planning for Network Traffic ................................................................................................... 2-8  
Apex Central Setup Flow .......................................................................................................... 2-9  
Testing Apex Central at One Location ..................................................................................... 2-9  
Preparing for the Test Deployment ......................................................................................... 2-10  
Selecting a Test Site .................................................................................................................. 2-11  
Beginning the Test Deployment .............................................................................................. 2-11  
Evaluating the Test Deployment ............................................................................................... 2-11  
Server Distribution Plan .......................................................................................................... 2-11  
Understanding Administration Models .................................................................................... 2-11  
Understanding Apex Central Server Distribution .................................................................. 2-12  
Single-Server Topology ............................................................................................................. 2-13  
Multiple-Server Topology ......................................................................................................... 2-13
Network Traffic Plan ................................................................................... 2-13
  Understanding Apex Central Network Traffic ..................................... 2-13
Source of Network Traffic ........................................................................... 2-15
  Log Traffic ............................................................................................. 2-15
  Trend Micro Management Communication Protocol Policies .... 2-16
  Product Registration Traffic ............................................................... 2-17
  Policy Deployment ............................................................................... 2-18
Deploying Updates ....................................................................................... 2-18
Data Storage Plan ......................................................................................... 2-19
  Database Recommendations ............................................................... 2-19
  ODBC Driver ....................................................................................... 2-21
  Authentication ...................................................................................... 2-21
Web Server Plan ........................................................................................... 2-21

Chapter 3: Installation

  System Requirements ..................................................................................... 3-2
  Installing the Apex Central Server ............................................................... 3-6
    Apex Central Installation Flow ............................................................... 3-7
    Installing All Required Components ................................................... 3-8
  Specifying the Installation Location .................................................. 3-11
  Activating the Product and Services ................................................ 3-12
  Specifying Apex Central Web Server Settings .................................. 3-13
  Specifying Backup Settings .................................................................. 3-14
  Setting Up the Root Account ............................................................... 3-16
  Configuring Database Information ................................................... 3-17

Chapter 4: Post-installation Tasks

  Automatic Post-installation Tasks .............................................................. 4-2
  Verifying the Server Installation or Upgrade .............................................. 4-2
  Activating Your Software ........................................................................... 4-4
    Activating Apex Central ............................................................... 4-5
    Converting to the Full Version ........................................................... 4-5
  Configuring Active Directory Connection Settings ................................ 4-6
Configuring User Accounts ................................................................. 4-9
Downloading the Latest Components ................................................. 4-9
Configuring Event Notifications ......................................................... 4-9

Chapter 5: Upgrades and Migration

Upgrading to Apex Central 2019 ......................................................... 5-2
  Supported Versions for Upgrade .................................................... 5-2
  Server Files to Back Up Before Migration .................................... 5-3
  Pre-migration Checklist .............................................................. 5-4

Upgrade and Migration Scenarios ...................................................... 5-5
  Upgrade Flow ............................................................................... 5-5
  Scenario 1: Upgrading a Control Manager Server to Apex Central 2019 ..................................................... 5-5
  Scenario 2: Migrating to a Fresh Apex Central 2019 Installation Using the Agent Migration Tool ........................................... 5-7

Planning Apex Central Agent Migration ........................................... 5-8
  Rapid Upgrade ............................................................................ 5-8
  Phased Upgrade .......................................................................... 5-9

Migrating the Apex Central Database .............................................. 5-9
  Migrating a Apex Central SQL Database to Another SQL Server 5-9

Chapter 6: Post-Migration Tasks

Verifying a Successful Upgrade or Migration ..................................... 6-2
Migrating Apex One Server Settings to Apex Central ....................... 6-2
Enabling Application Control ........................................................... 6-4
Enabling Vulnerability Protection ..................................................... 6-5
Enabling Endpoint Sensor ............................................................... 6-7
Configuring Apex One Server Settings for Endpoint Sensor .......... 6-9

Chapter 7: Uninstallation

Removing Apex Central ........................................................................ 7-2
Manually Removing Apex Central ............................................................... 7-3
Removing the Apex Central Application .............................................. 7-3

Chapter 8: Apex Central System Checklists

Server Address Checklist ............................................................................. 8-2
Port Checklist .................................................................................................. 8-3
Apex Central Conventions ............................................................................. 8-3
Core Processes and Configuration Files ..................................................... 8-4
Communication and Listening Ports ........................................................... 8-6

Index

Index .............................................................................................................. IN-1
Preface

Welcome to the Trend Micro Apex Central™ Installation and Upgrade Guide. This document discusses requirements and procedures for installing the Apex Central server, and upgrading from a previous installation.

Topics in this section:

• Documentation on page vi
• Audience on page vii
• Document Conventions on page vii
• Terminology on page viii
# Documentation

Apex Central documentation includes the following:

<table>
<thead>
<tr>
<th>DOCUMENT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readme file</td>
<td>Contains a list of known issues and may also contain late-breaking product information not found in the Online Help or printed documentation</td>
</tr>
<tr>
<td>Installation and Upgrade Guide</td>
<td>A PDF document that discusses requirements and procedures for installing the Apex Central</td>
</tr>
</tbody>
</table>

**Note**
The Installation and Upgrade Guide may not be available for minor release versions, service packs, or patches.

<table>
<thead>
<tr>
<th>DOCUMENT</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements</td>
<td>A PDF document that discusses requirements and procedures for installing Apex Central</td>
</tr>
<tr>
<td>Administrator's Guide</td>
<td>A PDF document that provides detailed instructions of how to configure and manage Apex Central and managed products, and explanations on Apex Central concepts and features</td>
</tr>
<tr>
<td>Online Help</td>
<td>HTML files compiled in WebHelp format that provide &quot;how to's&quot;, usage advice, and field-specific information. The Help is also accessible from the Apex Central console</td>
</tr>
<tr>
<td>Widget and Policy Management Guide</td>
<td>A PDF document that explains how to configure dashboard widgets and policy management settings in Apex Central</td>
</tr>
<tr>
<td>Automation API Guide</td>
<td>A PDF document that explains how to use Apex Central Automation APIs</td>
</tr>
<tr>
<td>Data Protection Lists (Chapter 1 only)</td>
<td>A PDF document that lists predefined data identifiers and templates for Data Loss Prevention</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>An online database of problem-solving and troubleshooting information. It provides the latest information about known product issues. To access the Knowledge Base, go to the following website: <a href="http://esupport.trendmicro.com">http://esupport.trendmicro.com</a></td>
</tr>
</tbody>
</table>
Download the latest version of the PDF documents and readme at:


**Audience**

Apex Central documentation is intended for the following users:

- **Apex Central Administrators**: Responsible for Apex Central installation, configuration, and management. These users are expected to have advanced networking and server management knowledge.

- **Managed Product Administrators**: Users who manage Trend Micro products that integrate with Apex Central. These users are expected to have advanced networking and server management knowledge.

**Document Conventions**

The documentation uses the following conventions.

**TABLE 1. Document Conventions**

<table>
<thead>
<tr>
<th>CONVENTION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>UPPER CASE</td>
<td>Acronyms, abbreviations, and names of certain commands and keys on the keyboard</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Menus and menu commands, command buttons, tabs, and options</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>References to other documents</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>Sample command lines, program code, web URLs, file names, and program output</td>
</tr>
<tr>
<td><strong>Navigation &gt; Path</strong></td>
<td>The navigation path to reach a particular screen</td>
</tr>
<tr>
<td></td>
<td>For example, <strong>File &gt; Save</strong> means, click <strong>File</strong> and then click <strong>Save</strong> on the interface</td>
</tr>
</tbody>
</table>
The following table provides the official terminology used throughout the Apex Central documentation:

<table>
<thead>
<tr>
<th>TERMINOLOGY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator (or Apex Central administrator)</td>
<td>The person managing the Apex Central server</td>
</tr>
<tr>
<td>Security Agent</td>
<td>The managed product program installed on an endpoint</td>
</tr>
<tr>
<td>Components</td>
<td>Responsible for scanning, detecting, and taking actions against security risks</td>
</tr>
<tr>
<td>Apex Central console, web console, or management console</td>
<td>The web-based user interface for accessing, configuring, and managing a Apex Central</td>
</tr>
</tbody>
</table>

- **Note**
  Consoles for integrated managed products are indicated by the managed product name. For example, the Apex One web console.
<table>
<thead>
<tr>
<th><strong>TERMINOLOGY</strong></th>
<th><strong>DESCRIPTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Managed endpoint</td>
<td>The endpoint where the managed product Security Agent is installed</td>
</tr>
<tr>
<td>Managed product</td>
<td>A Trend Micro product that integrates with Apex Central</td>
</tr>
<tr>
<td>Managed server</td>
<td>The endpoint where the managed product is installed</td>
</tr>
<tr>
<td>Server</td>
<td>The endpoint where the Apex Central server is installed</td>
</tr>
<tr>
<td>Security risk</td>
<td>The collective term for virus/malware, spyware/grayware, and web threats</td>
</tr>
<tr>
<td>Product service</td>
<td>Apex Central services hosted through Microsoft Management Console (MMC).</td>
</tr>
<tr>
<td>Dual-stack</td>
<td>Entities that have both IPv4 and IPv6 addresses</td>
</tr>
<tr>
<td>Pure IPv4</td>
<td>An entity that only has an IPv4 address</td>
</tr>
<tr>
<td>Pure IPv6</td>
<td>An entity that only has an IPv6 address</td>
</tr>
</tbody>
</table>
Chapter 1

Introducing Apex Central

This section introduces Trend Micro Apex Central™ and provides an overview of its features and capabilities.

Topics include:

• *About Apex Central on page 1-2*
• *Key Features and Benefits on page 1-2*
• *Apex Central Architecture on page 1-4*
About Apex Central

Trend Micro Apex Central™ is a web-based console that provides centralized management for Trend Micro products and services at the gateway, mail server, file server, and corporate desktop levels. Administrators can use the policy management feature to configure and deploy product settings to managed products and endpoints. The Apex Central web-based management console provides a single monitoring point for antivirus and content security products and services throughout the network.

Apex Central enables system administrators to monitor and report on activities such as infections, security violations, or virus/malware entry points. System administrators can download and deploy components, such as antivirus pattern files, scan engines, and antispam rules, throughout the network to ensure up-to-date protection. Apex Central allows both manual and pre-scheduled updates, and allows the configuration and administration of products as groups or as individuals for added flexibility.

Key Features and Benefits

Apex Central provides the following features and benefits.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Directory integration</td>
<td>Apex Central supports integration with multiple Active Directory forests and allows you to import Active Directory groups in addition to users. You can also enable Active Directory Federation Services (ADFS) authentication to allow users or groups from federated business partners across an extranet to securely log on to your Apex Central network.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Use the Dashboard tabs and widgets for extensive visibility of managed product and Apex Central information about threat detections, component statuses, policy violations, and more.</td>
</tr>
<tr>
<td>Operation Center</td>
<td>Use the Operation Center tab to gain instant insights into the antivirus pattern and Data Loss Prevention compliance status, critical threat detections, as well as resolved and unresolved events on your network.</td>
</tr>
</tbody>
</table>
## Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>User/Endpoint Directory</td>
<td>View detailed information about all the users and endpoints within the Apex Central network and any security threat detections.</td>
</tr>
<tr>
<td>Product Directory</td>
<td>System administrators can immediately deploy configuration modifications to managed products or even run a manual scan from the Apex Central web console during a virus/malware outbreak.</td>
</tr>
<tr>
<td>Global Policy Management</td>
<td>System administrators can use policies to configure and deploy product settings to managed products and endpoints from a single management console to ensure consistent enforcement of your organization’s virus/malware and content security policies.</td>
</tr>
<tr>
<td>Logs</td>
<td>Use a single management console to view consolidated logs from all registered managed products without having to log on to each individual product console.</td>
</tr>
<tr>
<td>Event Notifications</td>
<td>Keep administrators informed of network events at all times by configuring Apex Central to send notifications by email, Windows syslog, SNMP trap, or an in-house or industry-standard application used by your organization.</td>
</tr>
<tr>
<td>Reports</td>
<td>Create comprehensive reports from custom or static templates to obtain the actionable information you need to ensure network protection and security compliance.</td>
</tr>
<tr>
<td>Component Updates</td>
<td>Securely download and deploy antivirus patterns, antispam rules, scan engines, and other antivirus or content security components to help ensure that all managed products are up to date.</td>
</tr>
<tr>
<td>Connected Threat Defense</td>
<td>Apex Central brings together a host of Trend Micro products and solutions to help you detect, analyze, and respond to targeted attacks and advanced threats before they unleash lasting damage.</td>
</tr>
<tr>
<td>Secure communication infrastructure</td>
<td>Apex Central uses a communications infrastructure built on the Secure Socket Layer (SSL) protocol and can even encrypt messages with authentication.</td>
</tr>
<tr>
<td>Role-based Administration</td>
<td>Grant and control access to the Apex Central web console by assigning specific web console privileges to administrators and providing only the tools and permissions necessary to perform specific tasks.</td>
</tr>
</tbody>
</table>
### Feature and Benefits

<table>
<thead>
<tr>
<th>Feature</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Tracking</td>
<td>Command Tracking allows you to continuously monitor whether commands executed using the Apex Central web console, such as antivirus pattern updates and component deployment, have successfully completed.</td>
</tr>
<tr>
<td>License management</td>
<td>Deploy new Activation Codes or reactivate existing Activation Codes on managed products.</td>
</tr>
<tr>
<td>Security Agent installation</td>
<td>Download Security Agent installation packages for Apex One or Apex One (Mac) directly from the Apex Central console.</td>
</tr>
<tr>
<td>Two-Factor Authentication</td>
<td>Two-Factor Authentication provides extra security on user accounts by requiring users to type the verification code generated by the Google Authenticator app in order to sign in to Apex Central.</td>
</tr>
<tr>
<td>Browser support</td>
<td>This version of Apex Central includes support for the following:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Internet Explorer™</td>
</tr>
<tr>
<td></td>
<td>• Microsoft™ Edge™</td>
</tr>
<tr>
<td></td>
<td>• Google™ Chrome™</td>
</tr>
</tbody>
</table>

### Apex Central Architecture

Trend Micro Apex Central™ provides a means to control Trend Micro products and services from a central location. This application simplifies the administration of a corporate virus/malware and content security policy.

The following table describes the components that Apex Central uses.
## Introducing Apex Central

### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Apex Central server | Acts as a repository for all data collected from the agents. The Apex Central server includes the following features:  
  - An SQL database that stores managed product configurations and logs  
  
  Apex Central uses the Microsoft SQL Server database (db_ApexCentral.mdf) to store data included in logs, managed product information, user account, network environment, and notification settings.  
  - A web server that hosts the Apex Central web console  
  - A mail client that delivers event notifications through email messages  
  
  Apex Central can send notifications to individuals or groups of recipients about events that occur on the Apex Central network. Send event notifications by email, SNMP trap, syslog, or any in-house/industry standard application used by your organization to send notifications.  
  - A report server that generates antivirus and content security product reports  
  
  The Apex Central report is an online collection of figures about security threat and content security events that occur on the Apex Central network. |
| Trend Micro Management Communication Protocol | MCP handles the Apex Central server interaction with managed products that support the next generation agent.  
MCP agents install with managed products and use one/two way communication to communicate with Apex Central. MCP agents poll Apex Central for instructions and updates. |
| Web Service Integration communication | An agent-less integration model that allows Apex Central to communicate with managed products |
### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web-based management console</td>
<td>Allows an administrator to manage Apex Central from virtually any computer with an Internet connection and web browser. The Apex Central management console is a web-based console published on the Internet through the Microsoft Internet Information Server (IIS) and hosted by the Apex Central server. It lets you administer the Apex Central network from any computer using a compatible web browser.</td>
</tr>
<tr>
<td>Widget Framework</td>
<td>Allows an administrator to create a customized dashboard to monitor the Apex Central network.</td>
</tr>
</tbody>
</table>
Chapter 2

Installation Planning

This chapter helps you plan for deployment and manage a Apex Central test deployment.

Topics include:

• Identifying Deployment Architecture and Strategy on page 2-2
• Apex Central Setup Flow on page 2-9
• Testing Apex Central at One Location on page 2-9
• Server Distribution Plan on page 2-11
• Network Traffic Plan on page 2-13
• Source of Network Traffic on page 2-15
• Deploying Updates on page 2-18
• Data Storage Plan on page 2-19
• Web Server Plan on page 2-21
Identifying Deployment Architecture and Strategy

Deployment is the process of strategically distributing Apex Central servers in your network environment to facilitate and provide optimal management of antivirus and content security products.

Deploying enterprise-wide, client-server software like Apex Central to a network requires careful planning and assessment.

For ease of planning, Trend Micro recommends two deployment architectures:

• **Single-site deployment**: Refers to distributing and managing servers, managed products, and endpoints from a single Apex Central located in a central office. If your organization has several offices but has fast and reliable local and wide area network connections between sites, single-site deployment still applies to your environment.

• **Multiple-site deployment**: Refers to distributing and managing Apex Central servers in an organization that has main offices in different geographical locations.
Understanding Single-Site Deployment

Single-site deployment refers to distributing and managing servers, managed products, and endpoints from a single Apex Central located in a central office.

**Figure 2-1. A single-site deployment using a single Apex Central server**

Before deploying Apex Central to a single site, complete the following tasks:

1. Determine the number of managed products and endpoints
2. Plan for the optimal ratios of server, managed products and endpoints
3. Designate the Apex Central server

**Determining the Number of Managed Products and Endpoints**

Determine how many managed products and endpoints structures you plan to manage with Apex Central. You will need this information to decide what kind and how many Apex Central servers you need to deploy, as well as where to put these servers on your network to optimize communication and management.
Planning for the Optimal Ratios of Server to Managed Products

The most critical factor in determining how many managed products and endpoints a single Apex Central server can manage on a local network is the agent-server communication.

Use the recommended system requirements as a guide in determining the CPU and RAM requirements for your Apex Central network.

Designating Apex Central Servers

Based on the number of managed products and endpoints, decide and designate your Apex Central server.

Locate your Windows servers, and then select the ones to assign as Apex Central servers. You also need to determine if you need to install a dedicated server.

When selecting a server that will host Apex Central, consider the following:

- The CPU load
- Other functions the server performs

If you are installing Apex Central on a server that has other uses (for example, application server), Trend Micro recommends that you install on a server that is not running mission-critical or resource-intensive applications.

Depending on your network topology, you may need to perform additional site-specific tasks.

Understanding Multiple-Site Deployment

As with single-site deployment, collect relevant network information and identify how this information relates to deploying Apex Central to your multiple sites.

Given the uniqueness of each network, exercise judgment as to how many Apex Central servers would be optimal.

Deploy Apex Central servers in a number of different locations, including the demilitarized zone (DMZ) or the private network. Position the Apex Central server in
the DMZ on the public network to administer managed products, endpoints, or other servers and access the Apex Central web console over the Internet.

**Figure 2-2. A multi-site deployment using multiple Apex Central servers**

Consider the following for multi-site deployment:

- Group managed products, endpoints, or servers
- Determine the number of sites
- Determine the number of managed products, endpoints, and servers
- Plan for network traffic
- Decide where to install the Apex Central server

**Grouping Managed Products**

Consider the following when you group managed products:
### Table 2-1. Considerations Grouping Managed Products

<table>
<thead>
<tr>
<th>Consideration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company network and security policies</td>
<td>If different access and sharing rights apply to the company network, group managed products, endpoints, and servers according to company network and security policies.</td>
</tr>
<tr>
<td>Organization and function</td>
<td>Group managed products, endpoints, and servers according to the company’s organizational and functional division. For example, have two Apex Central servers that manage the production and testing groups.</td>
</tr>
<tr>
<td>Geographical location</td>
<td>Use geographical location as a grouping criterion if the location of the managed products, endpoints, and servers affects the communication between the Apex Central server and its managed products, endpoints, or servers.</td>
</tr>
<tr>
<td>Administrative responsibility</td>
<td>Group managed products, endpoints, and servers according to system or security personnel assigned to them. This allows group configuration.</td>
</tr>
</tbody>
</table>

### Determining the Number of Sites

Determine how many sites your Apex Central deployment will cover. You need this information to determine the number of servers to install, as well as where to install the servers.

Gather this information from your organization's WAN or LAN topology charts.

### Determining the Number of Managed Products and Endpoints

You also need to know the total number of managed products, and endpoints Apex Central server will manage. Trend Micro recommends gathering managed product, and endpoint population data per site. If you cannot get this information, even rough estimates will be helpful. You will need this information to determine how many servers to install.
Planning for the Optimal Ratio of Server to Managed Products

When deploying Apex Central across a WAN, the Apex Central server in the main office administers managed products, endpoints, and other servers in remote offices. Managed products, endpoints, or servers in remote offices may require different network bandwidth when communicating with the Apex Central server over a WAN. Apex Central prioritizes communication with the managed products, endpoints, or servers with the faster connections.

Use the recommended system requirements as a guide in determining the CPU and RAM requirements for your Apex Central network.

Designating Apex Central Servers

Based on the number of managed products and endpoints, decide and designate your Apex Central server.

Locate your Windows servers, and then select the ones to assign as Apex Central servers. You also need to determine if you need to install a dedicated server.

When selecting a server that will host Apex Central, consider the following:

• The CPU load
• Other functions the server performs

If you are installing Apex Central on a server that has other uses (for example, application server), Trend Micro recommends installing on a server that does not run mission-critical or resource-intensive applications.

Deciding Where to Install the Apex Central Server

Once you know the number of clients and the number of servers you need to install, find out where to install your Apex Central servers. Decide if you need to install all your servers in the central office or if you need to install some of them in remote offices.

Place the servers strategically in certain segments of your environment to speed up communication and optimize managed product, endpoint, and server management:
• **Central office**: A central office is the facility where the majority of the managed products, endpoints, and servers in the organization are located. The central office is sometimes referred to as headquarters, corporate office, or corporate headquarters. A central office can have other smaller offices or branches (referred to as "remote offices" in this guide) in other locations.

**Tip**

Trend Micro recommends installing a server in the central office.

• **Remote office**: A remote office is defined as any small professional office that is part of a larger organization and has a WAN connection to the central office. If you have managed products, endpoints, and servers in a remote office that report to the server in the central office, they may encounter difficulties connecting to the server. Bandwidth limitations may prevent proper communication to and from the Apex Central server.

The network bandwidth between your central office and remote office may be sufficient for routine client-server communication, such as notifications for updated configuration settings and status reporting, but insufficient for deployment and other tasks.

**Planning for Network Traffic**

Apex Central generates network traffic when the server and managed products/endpoints communicate. Plan the Apex Central network traffic to minimize the impact on an organization's network.

These are the sources of Apex Central-related network traffic:

• Heartbeat
• Logs
• Managed product registration to Apex Central server

Apex Central servers, by default, contain all the product profiles available during the Apex Central release. However, if you register a new version of a product to Apex Central, a version that does not correspond to any existing product profiles, the new product will upload its profile to the Apex Central server.
For brand-new Trend Micro products that have not had a product profile, Trend Micro delivers updates to enable Apex Central to identify these products.

- Downloading and deploying updates
- Policy deployment
- Suspicious object synchronization

Apex Central Setup Flow

Setting up your Apex Central system is a multi-step process that involves the following:

1. Planning the Apex Central system installation (server distribution, network traffic, data storage, and web server considerations).
2. Installing the Apex Central server.

**Note**

During installation of the Apex Central server, provide a location for backup and restoration files.

Testing Apex Central at One Location

A pilot deployment provides an opportunity for feedback to determine how features work and the level of support likely needed after full deployment.

**Tip**

Trend Micro recommends conducting a pilot deployment before performing a full-scale deployment.

Piloting Apex Central at one location allows you to accomplish the following:

- Gain familiarity with Apex Central and managed products
• Develop or refine the company’s network policies

A pilot deployment is useful to determine which configurations need improvements. It gives the IT department or installation team a chance to rehearse and refine the deployment process and to verify that your deployment plan meets your organization’s business requirements.

A Apex Central test deployment consists of the following tasks:

• Preparing for the test deployment
• Selecting a test site
• Beginning the test deployment
• Evaluating the test deployment

Preventing for the Test Deployment

Complete the following activities during the preparation stage.

Procedure

1. Decide the Apex Central server and agent configuration for the test environment.
   • Establish TCP/IP connectivity among all systems in a trial configuration.
   • Verify bidirectional TCP/IP communications by sending a ping command to each agent system from the manager system and vice versa.

2. Evaluate the different deployment methods to see which ones are suitable for your particular environment.

3. Complete a System Checklist used for the pilot deployment.
Selecting a Test Site

Select a pilot site that best matches your production environment. Try to simulate, as closely as possible, the type of topology that would serve as an adequate representation of your production environment.

Beginning the Test Deployment

After completing the preparation steps and System Checklist, begin the pilot deployment by installing the Apex Central server and agents.

Evaluating the Test Deployment

Create a list of successes and failures encountered throughout the pilot process. Identify potential pitfalls and plan accordingly for a successful deployment.

You can implement the pilot evaluation plan into the overall production installation and deployment plan.

Server Distribution Plan

Consider the following when planning for server distribution:

- Administration models
- Apex Central server distribution
- Single-server topology
- Multiple-server topology

Understanding Administration Models

Early in the Apex Central deployment, determine exactly how many people you want to grant access to your Apex Central server. The number of users depends on how
centralized you want your management to be. The guiding principle being: the degree of centralization is inversely proportional to the number of users.

Follow one of these administration models:

- **Centralized management**: This model gives Apex Central access to as few people as possible. A highly centralized network would have only one administrator, who then manages all the antivirus and content security servers on the network.

  Centralized management offers the tightest control over your network antivirus and content security policy. However, as network complexity increases, the administrative burden may become too much for one administrator.

- **Decentralized management**: This is appropriate for large networks where system administrators have clearly defined and established areas of responsibility. For example, the mail server administrator may also be responsible for email protection; regional offices may be independently responsible for their local areas.

  A main Apex Central administrator would still be necessary, but he or she shares the responsibility for overseeing the network with other product or regional administrators.

  Grant Apex Central access to each administrator, but limit access rights to view and/or configure segments of the Apex Central network that are under their responsibility.

With one of these administration models initialized, you can then configure the Product Directory and necessary user accounts to manage your Apex Central network.

**Understanding Apex Central Server Distribution**

Apex Central can manage products regardless of physical location, and so it is possible to manage all your antivirus and content security products using a single Apex Central server.

However, there are advantages to dividing control of your Apex Central network among different servers. Based on the uniqueness of your network, you can decide the optimum number of Apex Central servers.
Single-Server Topology

The single-server topology is suitable for small to medium, single-site enterprises. This topology facilitates administration by a single administrator, but does not preclude the creation of additional administrator accounts as required by your Administration plan.

However, this arrangement concentrates the burden of network traffic (agent polling, data transfer, update deployment, and so on) on a single server, and the LAN that hosts it. As your network grows, the impact on performance also increases.

Multiple-Server Topology

For larger enterprises with multiple sites, it may be necessary to set up regional Apex Central servers to divide the network load.

For information on the traffic that a Apex Central network generates, see Understanding Apex Central Network Traffic on page 2-13.

Network Traffic Plan

To develop a plan to minimize the impact of Apex Central on your network, it is important to understand the network traffic generated by Apex Central.

The following section helps you understand the traffic that your Apex Central network generates and develop a plan to minimize its impact on your network. In addition, the section about traffic frequency describes which sources frequently generate traffic on a Apex Central network.

Understanding Apex Central Network Traffic

To develop a plan to minimize the impact of Apex Central on your network, it is important to understand the network traffic generated by Apex Central.

Sources of Network Traffic

The following Apex Central sources generate network traffic:
• Log traffic
• MCP policies
• Product registration
• Downloading and deploying updates
• Deploying policy settings

Traffic Frequency

The following sources frequently generate traffic on a Apex Central network:

• Logs generated by managed products
• MCP polling and commands

Logs

Managed products send logs to Apex Central at different intervals, depending on their individual log settings.

Managed Product Agent Heartbeat

By default, managed product agents send heartbeat messages every 60 minutes. Administrators can adjust this value from 5 to 480 minutes (8 hours). When choosing a heartbeat setting, choose a balance between the need to display the latest status information and the need to manage system resources.

The default setting will be satisfactory for most situations, however should you feel the need to customize these settings, consider the following:

• **Long-Interval Heartbeats** (above 60 minutes): The longer the interval between heartbeats, the greater the number of events that may occur before the Apex Central console displays the interval.

  For example, if a connection problem with an agent is resolved between heartbeats, it then becomes possible to communicate with an agent even if its status appears as *Inactive* or *Abnormal.*
• **Short-Interval Heartbeats** (below 60 minutes): Short intervals between heartbeats present a more up-to-date picture of your network status at the Apex Central server. However, short-interval heartbeats increase the amount of network bandwidth used.

---

**Note**
Before adjusting the interval to a number below 15 minutes, study your existing network traffic to understand the impact of increased use of network bandwidth.

---

**Network Protocols**

Apex Central uses the UDP and TCP protocols for communication.

**Source of Network Traffic**

**Log Traffic**

Constant sources of network traffic in a Apex Central network are "product logs", logs that managed products regularly send to the Apex Central server.

**TABLE 2-2. Apex Central Log Traffic**

<table>
<thead>
<tr>
<th>LOG</th>
<th>CONTAINS INFORMATION ABOUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virus/Spyware/Grayware</td>
<td>Detected virus/malware, spyware/grayware, and other security threats</td>
</tr>
<tr>
<td>Security</td>
<td>Violations reported by content security products</td>
</tr>
<tr>
<td>Web Security</td>
<td>Violations reported by web security products</td>
</tr>
<tr>
<td>Event</td>
<td>Miscellaneous events (for example, component updates, and</td>
</tr>
<tr>
<td></td>
<td>generic security violations)</td>
</tr>
<tr>
<td>Status</td>
<td>The environment of a managed product. The Status tab of the</td>
</tr>
<tr>
<td></td>
<td>Product Directory displays this information</td>
</tr>
</tbody>
</table>
### Trend Micro Management Communication Protocol Policies

The Trend Micro Management Communication Protocol (MCP) is the Apex Central communications backbone. MCP implements the following policies:

<table>
<thead>
<tr>
<th><strong>Log</strong></th>
<th><strong>Contains Information About</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Virus</td>
<td>Viruses detected in network packets</td>
</tr>
<tr>
<td>Performance Metric</td>
<td>Used for previous product versions</td>
</tr>
<tr>
<td>URL Usage</td>
<td>Violations reported by web security products</td>
</tr>
<tr>
<td>Security Violation</td>
<td>Violations reported by Network VirusWall products.</td>
</tr>
<tr>
<td>Security Compliance</td>
<td>Endpoint compliances reported by Network VirusWall products.</td>
</tr>
<tr>
<td>Security Statistic</td>
<td>The difference between security compliances and security violations calculated and reported by Network VirusWall products.</td>
</tr>
<tr>
<td>Endpoint</td>
<td>Violations reported by Web security products.</td>
</tr>
<tr>
<td>Data Loss Prevention Log</td>
<td>Detections related to Data Loss Prevention policy violations</td>
</tr>
<tr>
<td>Behavior Monitoring Log</td>
<td>Behavior-based malicious activity detections</td>
</tr>
<tr>
<td>Network Inspection Log</td>
<td>Includes IP address or domain detections</td>
</tr>
<tr>
<td>Predictive Machine Learning Log</td>
<td>Predictive Machine Learning detections</td>
</tr>
<tr>
<td>Virtual Analyzer Log</td>
<td>Detections reported by Virtual Analyzer for suspicious sample submissions</td>
</tr>
<tr>
<td>File Hash Detection Log</td>
<td>Detections triggered by File or File SHA-1 suspicious objects</td>
</tr>
</tbody>
</table>
• **MCP Heartbeat**: The MCP heartbeats to Apex Central ensure that Apex Central displays the latest information and that the connection between the managed product and the Apex Central server is functional.

• **MCP Command Polling**: When an MCP agent initiates a command poll to Apex Central, Apex Central notifies the agent to send managed product logs or issues a command to the managed product. Apex Central also interprets a command poll as a passive heartbeat verifying the connection between Apex Central and the managed product.

**Product Registration Traffic**

Product profiles provide Apex Central with information about how to manage a particular product. Managed products upload profiles to the Apex Central server the first time they register with the server.

Each product has a corresponding product profile, and in many cases, different versions of a product have their own, version-specific profile. Profiles contain the following information:

- Category (for example, antivirus)
- Product name
- Product version
- Menu version
- Log format
- Update component information – updates that the product supports (for example, virus pattern files)
- Command information

By default, Apex Central servers contain all the product profiles for managed products that use Web Services Integration communication. Managed products that use the Trend Micro Management Communication Protocol (MCP) upload product profiles during initial registration with the Apex Central server.
Policy Deployment

Apex Central generates network traffic when deploying policy settings to managed products and endpoints. The traffic originates from the following sources:

- Periodic policy enforcement
  Apex Central enforces the policy settings on managed products and endpoints every 24 hours.

- Deployed information
  A policy contains the Globally Unique Identifier (GUID) information for each endpoint and the setting information. A policy containing 50,000 targets and a full set of settings can generate up to 1.8MB of network traffic.

Deploying Updates

Updating the Apex Central network is a two-step process:

1. Obtain the latest update components from Trend Micro.
   Apex Central can download components either directly from the Trend Micro update server, or from an alternative location.

2. Deploy these components to the managed products.
   Apex Central deploys update components to managed products, including:
   - Pattern files/Cleanup templates
   - Engines (scan engines, damage cleanup engines)
   - Antispam rules
   - Apex One Plug-in Manager Plug-in Programs
   - Product programs (depending on the product)
Tip

Trend Micro strongly recommends regularly updating these components to help ensure managed products can protect your network against the latest threats. For product program updates, refer to the specific program’s documentation.

Deploying updates to managed products is a bandwidth-intensive operation. If possible, it is important to perform deployments when they will have the least impact on the network.

You can stagger the deployment of component updates using Deployment Plans.

Furthermore, check that the network connection between your Apex Central server and managed products can accommodate the updates. The connection is a factor to consider when deciding how many Apex Central servers your network needs.

Data Storage Plan

Apex Central data must be stored in an SQL database. When you install Apex Central on a server that does not have its own database, the installation program provides the option to install the Microsoft SQL Express. However, due to the limitations of SQL Express, large networks require an SQL server.

Note

Apex Central uses SQL and Windows authentication to access the SQL server.

Database Recommendations

This section provides recommendations for administrators when installing Apex Central and the SQL server on the same computer.

- Production environment
  - Use a computer with more than 10GB of disk space
Note

The minimum disk space requirement to install Apex Central is 10GB, but the recommended requirement is 80GB. Trend Micro recommends at least 80GB of disk space for installing Apex Central and the SQL server on the same computer.

- Configure the maximum amount of memory used by the SQL server
  Leave at least 8GB of memory for Apex Central and system usage.
  For example, if a computer has 80GB of memory, set the maximum memory usage of the SQL server to 72GB. In this case, 8GB of memory is available for Apex Central and system usage.

- Test environment
  Leave at least 8GB of memory for Apex Central and system usage.

Note

For details on how to configure memory usage for the SQL server, see https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/server-memory-server-configuration-options.

Tip

- For Apex Central managing more than 1,000 products (including Apex One Security Agents and ServerProtect Normal servers), Trend Micro recommends using a dedicated SQL server.

- If Apex Central and the SQL server are installed on different computers, set the same time zone on both computers.

- Trend Micro highly recommends using Microsoft SQL Server Standard or Enterprise Edition. SQL Express is suitable for testing purposes but not for production environments.
ODBC Driver

Apex Central installs Open Database Connectivity (ODBC) Driver 13 for SQL Server to support Microsoft SQL Server communications and Transport Layer Security (TLS) 1.2.

Authentication

Apex Central supports both SQL database authentication and Windows authentication.

Web Server Plan

The web server information screen in the Apex Central setup program presents similar server identification options as the host ID definition screen: host name, FQDN, or IP address. The decision considerations for the web server name are the same:

- Using the host name or FQDN facilitates Apex Central server IP address changes, but makes the system dependent on the DNS server
- The IP address option requires a fixed IP

Use the web server address to identify the source of component updates. The SystemConfiguration.xml file stores this information and sends it to agents as part of a notification for these agents to obtain updates from the Apex Central server. Update source related settings appear as follows:

Value=http://Web server address>:port>/TvcsDownload/ActiveUpdate/component>

Where:

- **Port**: The port that connects to the update source. You can also specify this on the web server address screen (default port number is 80)
- **TvcsDownload/ActiveUpdate**: The Apex Central setup program creates this virtual directory in the IIS-specified website
- **Component**: This depends on the updated component. For example, when the virus pattern file is updated, the value added here is:
Pattern/vsapi.zip

Pattern corresponds to the `\.\.\Control Manager\WebUI\download\activeupdate\pattern` folder on the Apex Central server. Vsapi.zip is the virus pattern in compressed form.
Chapter 3

Installation

This chapter guides you through installing the Apex Central server. The chapter also contains post-installation configuration information as well as instructions on how to register and activate your software.

Topics include:

•  System Requirements on page 3-2
•  Installing the Apex Central Server on page 3-6
System Requirements

Apex Central 2019 runs on Windows Server 2012 (or above) and requires specific Windows features and hotfixes in order to install. Apex Central also requires Microsoft SQL Server 2008 (or above), at least 8 GB of RAM, and at least 10 GB of available disk space.

- For detailed managed product and Security Agent system requirements, see the managed product documentation.

The following tables list the minimum requirements for running the Apex Central installation program.

- Windows Server 2012 on page 3-3
- Windows Server 2012 R2 on page 3-3
- Windows Server 2016 on page 3-4
- Windows Server 2019 on page 3-5

---

**Note**

- The following Windows hotfixes are not automatically installed by Windows Updates but are required for the respective operating systems prior to 2019 installation:
  - KB2999226
  - KB2919355
  - KB2919442

- The following Windows hotfixes are only required for the respective operating systems to support TLS 1.2:
  - KB2975331
  - KB3000850
### Table 3-1. Windows Server 2012

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| Editions (no Service Pack required) | • Standard  
• Datacenter                                                             |
| Processor                 | • At least 2.3 GHz Intel™ Core™ i5 or compatible CPUs  
• AMD™ 64 processor  
• Intel™ 64 processor |
| RAM                       | • 8 GB minimum                                                              |
| Available Disk Space      | • 10 GB minimum  
• 80 GB recommended (SAS)                                                   |
| Windows Features          | • Microsoft IIS 8.0  
• Microsoft IIS 6.0 Management Compatibility  
• Microsoft IIS Windows Authentication  
• Microsoft IIS ASP  
• Microsoft IIS ASP.NET 4.5  
• Microsoft IIS ASP.NET Extensibility 4.5  
• Microsoft IIS CGI  
• Microsoft Message Queuing Service (MSMQ)                                 |
| Windows Hotfixes          | • KB2999226  
• KB2975331                                                               |

### Table 3-2. Windows Server 2012 R2

<table>
<thead>
<tr>
<th>Item</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| Editions (no Service Pack required) | • Standard  
• Datacenter |
<table>
<thead>
<tr>
<th>ITEM</th>
<th>REQUIREMENT</th>
</tr>
</thead>
</table>
| Processor            | • At least 2.3 GHz Intel™ Core™ i5 or compatible CPUs  
|                      | • AMD™ 64 processor                              
|                      | • Intel™ 64 processor                             |
| RAM                  | • 8 GB minimum                                   |
| Available Disk Space | • 10 GB minimum                                  
|                      | • 80 GB recommended (SAS)                        |
| Windows Features     | • Microsoft IIS 8.5                              
|                      | • Microsoft IIS 6.0 Management Compatibility      
|                      | • Microsoft IIS Windows Authentication            
|                      | • Microsoft IIS ASP                              
|                      | • Microsoft IIS ASP.NET 4.5                      
|                      | • Microsoft IIS ASP.NET Extensibility 4.5        
|                      | • Microsoft IIS CGI                              
|                      | • Microsoft Message Queuing Service (MSMQ)       |
| Windows Hotfixes     | • KB2919355                                      
|                      | • KB2919442                                      
|                      | • KB3000850                                      |

**TABLE 3-3. Windows Server 2016**

<table>
<thead>
<tr>
<th>ITEM</th>
<th>REQUIREMENT</th>
</tr>
</thead>
</table>
| Editions (no Service Pack required)| • Standard                                       
|                                   | • Datacenter                                     |
| Processor                         | • At least 2.3 GHz Intel™ Core™ i5 or compatible CPUs  
|                                   | • AMD™ 64 processor                              
|                                   | • Intel™ 64 processor                             |
### Installation

<table>
<thead>
<tr>
<th><strong>ITEM</strong></th>
<th><strong>Requirement</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>• 8 GB minimum</td>
</tr>
<tr>
<td>Available Disk Space</td>
<td>• 10 GB minimum</td>
</tr>
<tr>
<td></td>
<td>• 80 GB recommended (SAS)</td>
</tr>
<tr>
<td>Windows Features</td>
<td>• Microsoft IIS 10.0</td>
</tr>
<tr>
<td></td>
<td>• Microsoft IIS 6.0 Management Compatibility</td>
</tr>
<tr>
<td></td>
<td>• Microsoft IIS Windows Authentication</td>
</tr>
<tr>
<td></td>
<td>• Microsoft IIS ASP</td>
</tr>
<tr>
<td></td>
<td>• Microsoft IIS ASP.NET 4.6</td>
</tr>
<tr>
<td></td>
<td>• Microsoft IIS ASP.NET Extensibility 4.6</td>
</tr>
<tr>
<td></td>
<td>• Microsoft IIS CGI</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Message Queuing Service (MSMQ)</td>
</tr>
<tr>
<td>Windows Hotfixes</td>
<td>• N/A</td>
</tr>
</tbody>
</table>

**Table 3-4. Windows Server 2019**

<table>
<thead>
<tr>
<th><strong>ITEM</strong></th>
<th><strong>Requirement</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Editions (no Service Pack required)</td>
<td>• Standard</td>
</tr>
<tr>
<td></td>
<td>• Datacenter</td>
</tr>
<tr>
<td>Processor</td>
<td>• At least 2.3 GHz Intel™ Core™ i5 or compatible CPUs</td>
</tr>
<tr>
<td></td>
<td>• AMD™ 64 processor</td>
</tr>
<tr>
<td></td>
<td>• Intel™ 64 processor</td>
</tr>
<tr>
<td>RAM</td>
<td>• 8 GB minimum</td>
</tr>
<tr>
<td>Available Disk Space</td>
<td>• 10 GB minimum</td>
</tr>
<tr>
<td></td>
<td>• 80 GB recommended (SAS)</td>
</tr>
</tbody>
</table>
Installing the Apex Central Server

After deciding on the topology to use for your network, you can begin to install your Apex Central server.

See *Server Address Checklist on page 8-2* to help you record relevant information for installation.

You need the following information for the installation:

- Relevant target server address and port information
- Apex Central Registration Key
- Security Level to use for Server-Agent communication

The following are database-related considerations:

- Decide if you want to use an SQL server with Apex Central. If the SQL server is located on a server other than the Apex Central server, obtain its IP address, FQDN, or NetBIOS name. If there are multiple instances of the SQL server, identify the one that you intend to use
• Prepare the following information about the SQL database for Apex Central:
  • User name for the database
  • Password

**Note**
Apex Central allows you to use Windows authentication or SQL authentication to access the SQL server.

• Determine the number of managed products that Apex Central will handle. If an SQL server is not detected on the server, Apex Central installs SQL Server 2017 Express, which can only handle a limited number of connections

**Apex Central Installation Flow**

Installing Apex Central requires performing the following steps:

1. Install all required components
2. Specify the installation location
3. Register and activate the product and services
4. Specify the backup settings
5. Set up the root account
6. Configure database information

**Tip**
Trend Micro recommends upgrading to version 2019 instead of doing a fresh installation.
Installing All Required Components

Procedure

1. Run the Apex Central installation program (Trend Micro Apex Central.exe) on the server.

   The installation program checks your system for required components.
   • If .NET Framework 4.6.1 or above is not already installed, proceed to step 2.
   • If .NET Framework 4.6.1 or above is already installed, skip to step 3.

2. Click Accent and Install to accept the Microsoft license terms and install the framework.

   The installation program installs .NET Framework 4.6.1.

   **Note**
   You may need to restart the server to after installing the missing component.

3. Click Yes to continue the installation.
The Welcome screen appears.

![Welcome Screen](image)

**FIGURE 3-1. The Welcome screen**

The installation program checks your system for existing components. Before proceeding with the installation, close all instances of the Microsoft Management Console.

4. Click Next.
The **Software License Agreement** screen appears.

![Software License Agreement Screen](image)

**Figure 3-2. Agree with the License Agreement**

5. Read the terms of the license agreement and choose one of the following:

   - If you do not agree with the terms of the license, click **No**.
     
     The installation stops.
   
   - To proceed with the installation, click **Yes**.

   The **Local System Environment Analysis Screen** appears.

---

**Note**

If a SQL server database is not already installed, the installation program will install Microsoft SQL Server 2017 Express at the end of the procedure.

For more information, see *Configuring Database Information on page 3-17*. 

---
Specifying the Installation Location

Procedure

1. Click **Next**.

   The **Select Destination Folder** screen appears.

   ![Select Destination Folder Screen]

   **FIGURE 3-3. Select a destination folder**

2. Specify a location for Apex Central files. Click **Browse** to specify an alternate location.
Note

- The default location on 64-bit operating systems is \Program Files (x86)\Trend Micro.
- The setup program installs files related to Apex Central communication (MCP) in predetermined folders in the Program Files folder.

Activating the Product and Services

Procedure

1. Click Next.

The Product Activation screen appears.

![Figure 3-4. Provide the Activation Code to activate and services](image)
2. Type the Apex Central Activation Code in the space provided.

## Specifying Apex Central Web Server Settings

### Procedure

1. Click Next.

   The **Specify Web Server Information** screen appears.

   The settings on the **Specify Web Server Information** screen define communication security and how the Apex Central network identifies your server.

   ![Specify web server information](image)

   **Figure 3-5. Specify web server information**

2. From the **Web site** list, select the website to access Apex Central.
3. From the IP address list, select the FQDN/host name, IPv4, or IPv6 address you want to use for the Apex Central Management Console. This setting defines how the Apex Central communication system identifies your Apex Central server. The setup program attempts to detect both the server's fully qualified domain name (FQDN) and IP address and displays them in the appropriate field.

If your server has more than one network interface card, or if you assign your server more than one FQDN, the names and IP addresses appear here. Choose the most appropriate address or name by selecting the corresponding option or item in the list.

If you use the host name or FQDN to identify your server, make sure that this name can be resolved on the product computers; otherwise the products cannot communicate with the Apex Central server.

4. From the **Web access security level** list, select one of the following security levels for Apex Central communication:

   - **High - HTTPS only**: All Apex Central communication uses HTTPS protocol. This ensures the most secure communication between Apex Central and other products.

   - **Medium - HTTPS primary**: If supported all Apex Central communication uses HTTPS protocol. If HTTPS is unavailable, agents use HTTP instead. This is the default setting when installing Apex Central.

   - **Low - HTTP based**: All Apex Central communication uses HTTP protocol. This is the least secure communication method between Apex Central and other products.

---

**Specifying Backup Settings**

**Procedure**

1. Click Next.
The **Choose Destination Location** screen appears.

**Figure 3-6. Choose a destination location for backup and authentication files**

2. Specify the location of the Apex Central backup and authentication files. Click **Browse** to specify an alternate location.

**Note**

The default location on 64-bit operating systems is `C:\Program Files (x86)\Trend Micro\CmKeyBackup`.

For more information, see *Server Files to Back Up Before Migration on page 5-3*. 
Setting Up the Root Account

Procedure

1. Click Next.

   The following screen appears.

   ![Figure 3-7. Provide information for the Apex Central root account](image)

   **FIGURE 3-7. Provide information for the Apex Central root account**

2. Provide the following account information:
   - User name (required)
   - Full name
   - Password (required)
• Confirm password (required)
• Email address

Configuring Database Information

Procedure

1. Click Next.

The Setup Apex Central Database screen appears.

![Setup Apex Central Database Screen](image)

**FIGURE 3-8. Choose the Apex Central database**

2. Select a database to use with Apex Central.
   - **Install Microsoft SQL Express**: The setup program automatically selects this option if an SQL server is not installed on this computer. Do not forget to specify a password for this database in the field provided.
Tip

Microsoft SQL Server Express is suitable only for a small number of connections. Trend Micro recommends using an SQL server for large Apex Central networks.

- **SQL Server**: The setup program automatically selects this option if the program detects an SQL server on the server. Provide the following information:

  - **SQL Server (\Instance)**: This server hosts the SQL server that you want to use for Apex Central. If an SQL server is present on your server, the setup program automatically selects it.

  To specify an alternative server, identify it using its FQDN, IPv4 address, or NetBIOS name.

  If more than one instance of SQL server exists on a host server (this can be either the same server where you are installing Apex Central, or another server), you must specify the instance. For example: `your_sql_server.com\instance`

Note

If users choose to use a remote SQL server, do not specify an IPv6 address in the SQL Server field. Apex Central cannot identify the remote database by its IPv6 address.

3. Provide credentials to access the SQL server in **Database authentication**.

WARNING!

For security reasons, do not use an SQL database that is not password protected.
Important

Both the **SQL Server Account** and **Windows Account** should meet the following requirements:

- Belongs to the “Administrators Group”
- Contains the “Log on as a service” user right
- Contains the “db_creator” or “db_owner” database roles
  - The “db_creator” role is required if creating a new database (the target database does not already exists).
  - The “db_owner” role is sufficient if the target database already exists.

Tip

If using an existing database, Trend Micro strongly recommends preparing an empty database for Apex Central installation.

- **SQL Server Account**
  
  By default, the user name is sa.

- **Windows Account**
  
  Type the user name in the following format: `domain name\user name`.

4. Under **Trend Micro Apex Central database**, provide a name for the Apex Central database.

   The default name is `db_ApexCentral`.

5. Click **Next** to create the required database. If the setup program detects an existing Apex Central database, you have the following options:

   - **Delete existing records, and create a new database**: The existing database is deleted, and another is created using the same name.

   - **Create a new database with a new name**: You are returned to the previous screen to allow you to change your Apex Central database name.

6. Click **Next**.
7. Click **Finish** to complete the installation.

**Figure 3-9.** Setup complete
Chapter 4

Post-installation Tasks

This chapter discusses the tasks Trend Micro recommends performing after the Apex Central installation completes.

Topics include:

• Automatic Post-installation Tasks on page 4-2
• Verifying the Server Installation or Upgrade on page 4-2
• Activating Your Software on page 4-4
• Configuring Active Directory Connection Settings on page 4-6
• Configuring User Accounts on page 4-9
• Downloading the Latest Components on page 4-9
• Configuring Event Notifications on page 4-9
Automatic Post-installation Tasks

Apex Central automatically performs the following tasks after successfully upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3.

- Migrate previously configured Active Directory server settings
- Synchronize Active Directory server data

Verifying the Server Installation or Upgrade

After completing the installation or upgrade, verify the following items:

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programs list</td>
<td>The following programs appear on the Add/Remove Programs list (Control Panel &gt; Add/Remove Programs) on the server computer.</td>
</tr>
<tr>
<td></td>
<td>• Trend Micro Apex Central</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Report Viewer 2012 Runtime</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2017</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2017 Native Client</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2017 Setup</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server 2017 Setup Support Files</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server Browser</td>
</tr>
<tr>
<td></td>
<td>• Microsoft SQL Server VSS Writer</td>
</tr>
</tbody>
</table>
### Directory folders

The following folders appear in the `C:\Program Files (x86)` directory on the server computer:

- Trend Micro\CmKeyBackup
- Trend Micro\COMMON\TMI
- Trend Micro\Control Manager

### Apex Central Database files

- `db_ApexCentral.mdf`
- `db_ApexCentral_Log.LDF`

### The setup program creates the following services and processes:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apex Central services</td>
<td>Trend Micro Apex Central</td>
</tr>
<tr>
<td></td>
<td>Trend Micro Management Infrastructure</td>
</tr>
<tr>
<td>IIS process</td>
<td><code>w3wp.exe</code> (Internet Information Services)</td>
</tr>
<tr>
<td>ISAPI filters</td>
<td><code>CCGIRedirect</code></td>
</tr>
<tr>
<td></td>
<td><code>ReverseProxy</code></td>
</tr>
<tr>
<td></td>
<td><code>TmcmRedirect</code></td>
</tr>
</tbody>
</table>
### Item Description

<table>
<thead>
<tr>
<th>Apex Central processes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>• CasProcessor.exe</td>
<td></td>
</tr>
<tr>
<td>• CMEFScheduler.NET.exe</td>
<td></td>
</tr>
<tr>
<td>• CmdProcessor.exe</td>
<td></td>
</tr>
<tr>
<td>• CmdProcessor.NET.exe</td>
<td></td>
</tr>
<tr>
<td>• LogForwarder.exe</td>
<td></td>
</tr>
<tr>
<td>• LogProcessor.exe</td>
<td></td>
</tr>
<tr>
<td>• LogReceiver.exe</td>
<td></td>
</tr>
<tr>
<td>• LogRetriever.exe</td>
<td></td>
</tr>
<tr>
<td>• MDRProcessor.NET.exe</td>
<td></td>
</tr>
<tr>
<td>• MsgReceiver.exe</td>
<td></td>
</tr>
<tr>
<td>• ProcessManager.exe</td>
<td></td>
</tr>
<tr>
<td>• ReportServer.exe</td>
<td></td>
</tr>
<tr>
<td>• sCloudProcessor.NET.exe</td>
<td></td>
</tr>
<tr>
<td>• TICAgentForMDR.exe</td>
<td></td>
</tr>
</tbody>
</table>

### Activating Your Software

Activating Apex Central allows you to use all of the product features, including downloading updated program components.

For more information, see the following topics:

- *Activating Apex Central on page 4-5*
- *Converting to the Full Version on page 4-5*
Activating Apex Central

The **License Management** screen allows you to activate Apex Central after obtaining an Activation Code from your Trend Micro sales representative or reseller.

If you purchased a license for Apex One Sandbox as a Service, you can also activate the license from the **License Management** screen.

**Important**

After activating Apex Central, log off and then log on to the Apex Central web console for changes to take effect.

**Procedure**

1. Go to **Administration > License Management > Apex Central**.
   
   The **License Information** screen appears and displays the current license information.

2. Click the **Specify a new Activation Code** link.

3. Type your Activation Code.

4. Click **Activate**.

5. Log off and then log on to the Apex Central web console for the changes to take effect.

Converting to the Full Version

Activate your Apex Central to continue to use it beyond the evaluation period. Activate Apex Central to use its full functionality including downloading updated program components.

**Procedure**

1. Purchase a full version Registration Key from a Trend Micro reseller.
2. Register your software online.

3. Obtain an Activation Code.

4. Activate Apex Central according to the instructions in the procedure above.

---

## Configuring Active Directory Connection Settings

Specify the connection settings to allow Apex Central to synchronize endpoint and user information from Active Directory servers.

---

### Note

Apex Central supports synchronization with multiple Active Directory forests. Adding an Active Directory domain automatically synchronizes all domains from the same forest.

For more information about forest trusts, contact your Active Directory administrator.

---

### Procedure

1. Go to Administration > Settings > Active Directory and Compliance Settings.

2. Click the Active Directory Settings tab.

3. Select Enable Active Directory synchronization and authentication.

4. Configure the connection settings to access an Active Directory server.

<table>
<thead>
<tr>
<th><strong>FIELD</strong></th>
<th><strong>DESCRIPTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Server address</td>
<td>Type the FQDN or IP address (IPv4 or IPv6) of the Active Directory server.</td>
</tr>
</tbody>
</table>
Post-installation Tasks

<table>
<thead>
<tr>
<th><strong>FIELD</strong></th>
<th><strong>DESCRIPTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>Type the domain name and user name required to access the Active Directory server.</td>
</tr>
<tr>
<td></td>
<td>Example format, <code>domain\user_name</code></td>
</tr>
<tr>
<td>Password</td>
<td>Type the password required to access the Active Directory server.</td>
</tr>
</tbody>
</table>

- To add another Active Directory server, click the add icon (➕).
- To delete an Active Directory server, click the delete icon (➖).

5. From the **Synchronization frequency (in hours)** drop-down list, select how often Apex Central synchronizes data with Active Directory servers.

    **Note**
    Active Directory synchronization times vary based on the size and complexity of the Active Directory database. You may need to wait for more than an hour before synchronization completes.

6. (Optional) Expand **Advanced settings** to configure the **Synchronization source** or **Connection mode**.

   a. Select one of the following synchronization sources:

      - **Domain controllers**: Synchronizes all domains from multiple forests with trust relationships
      - **Global catalog**: Synchronizes all domains from a single forest

      **Important**
      Some information used by Apex Central, such as geographic location and user membership in global groups or domain local groups, cannot be synchronized from a global catalog with default settings. Choose to synchronize from a global catalog only if your network policy restricts Apex Central from connecting to all domain controllers.

   b. Select one of the following connection modes:
• **SSL**

**Important**

To use an SSL connection, import the Active Directory Certificate to the Apex Central server.

• **Non-SSL**

7. (Optional) Click **Test Connection** to test the server connection.

**Note**

Testing the connection does not save the Active Directory server settings.

The Active Directory server connection status icon (✔️ or ❌) appears in front of the server address.

8. Click **Save**.

After configuring and saving Active Directory server connection settings, you can perform the following tasks:

• Click **Synchronize Now** to manually synchronize data with Active Directory servers.

The Active Directory server connection status icon (✔️ or ❌) appears in front of the server address.

• Click **Clear Data** to manually clear data for removed Active Directory servers from the Apex Central database.

**Note**

Clicking **Clear Data** triggers a scheduled task, which runs every 2 minutes, to purge all data of the removed Active Directory servers from the Apex Central database.
**Configuring User Accounts**

Create Apex Central user accounts based on your needs. Consider the following when creating your accounts:

- The number of different user roles (Administrators, Power Users, and Operators)
- Assign appropriate permissions and privileges to each user role
- For users to take advantage of the more advanced functions, they need to have Power User rights or greater

**Downloading the Latest Components**

After the installation, manually download the latest components (Pattern files\Cleanup templates, Engine updates) from the Trend Micro ActiveUpdate server to help maintain the highest security protection. If a proxy server exists between a Trend Micro server and the Internet, configure the proxy server settings (in the web console, select **Administration > Settings > Proxy Settings**).

**Configuring Event Notifications**

After the installation, configure the events that will trigger notifications to monitor significant virus/malware attacks and related security activities. Besides specifying notification recipients, choose notification channels and test them to make sure they work as expected (in the web console, go to **Detections > Notifications > Event Notifications**).
Chapter 5

Upgrades and Migration

This chapter discusses how to upgrade or migrate to Apex Central 2019 from a previous version of Apex Central.

Topics include:

• Upgrading to Apex Central 2019 on page 5-2
• Upgrade and Migration Scenarios on page 5-5
• Planning Apex Central Agent Migration on page 5-8
• Migrating the Apex Central Database on page 5-9
Upgrading to Apex Central 2019

Migrating a Control Manager installation to Apex Central 2019 preserves all your previous settings, logs, reports, Product Directory structure, and integrated Active Directory structure.

**Important**
- Apex Central 2019 only supports upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3, Control Manager 7.0, or Control Manager 7.0 Patch 1.
- Before migrating to Apex Central 2019, ensure that your server has sufficient system resources.


**WARNING!**
Always back up the existing server before performing the upgrade.

For more information, see *Server Files to Back Up Before Migration on page 5-3*.

**Supported Versions for Upgrade**

Apex Central 2019 supports upgrading from the following versions:
- Control Manager 6.0 Service Pack 3 Patch 3
- Control Manager 7.0
- Control Manager 7.0 Patch 1

**WARNING!**
Always back up the existing server before performing the upgrade.
Server Files to Back Up Before Migration

Before performing upgrading or migrating a previous Control Manager installation to Apex Central 2019, create a backup of the following server files:

<table>
<thead>
<tr>
<th>INFORMATION</th>
<th>LOCATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Use SQL Server Management Studio to back up the database.</td>
</tr>
<tr>
<td></td>
<td>• For migration from a previous version of Control Manager, the database name is <code>db_ControlManager</code>.</td>
</tr>
<tr>
<td></td>
<td>• For Apex Central 2019 (or later), the database name is <code>db_ApexCentral</code>.</td>
</tr>
<tr>
<td>Authentication</td>
<td>\Program Files (x86)\Trend Micro\CmKeyBackup*. * (Ensures that managed products reporting to the Apex Central server will report to the same server if Apex Central is restored)</td>
</tr>
<tr>
<td>ActiveUpdate files</td>
<td>\Program Files (x86)\Trend Micro\Control Manager\webui\download\Activeupdate</td>
</tr>
<tr>
<td>Control Manager</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\TrendMicro \TVCS</td>
</tr>
<tr>
<td>registry</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\TrendMicro \CommonCGI</td>
</tr>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft \Windows\CurrentVersion\Uninstall\TMCM</td>
</tr>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSSQLServer</td>
</tr>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services \TMCM</td>
</tr>
<tr>
<td>Control Manager</td>
<td>HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services \TrendMicro_NTP</td>
</tr>
<tr>
<td>registry</td>
<td>HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services \TrendCCGI</td>
</tr>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services \MSSQL$SQLEXPRESS</td>
</tr>
</tbody>
</table>
Pre-migration Checklist

Before upgrading or migrating Control Manager to Apex Central 2019, ensure that your system satisfies the following requirements:

⚠️ **Important**

Apex Central 2019 only supports upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3, Control Manager 7.0, or Control Manager 7.0 Patch 1.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>REQUIREMENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows Server 2012 or above</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>If you are running Control Manager on an operating system that is older than Windows Server 2012, you will need to upgrade or migrate to Windows Server 2012 or above.</td>
</tr>
<tr>
<td>Available Disk Space</td>
<td>10 GB minimum</td>
</tr>
<tr>
<td></td>
<td>80 GB recommended (SAS)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>If you are running Control Manager on a server with less than 10 GB of available disk space, you will need to migrate to server with at least 10 GB (80 GB recommended) of available disk space.</td>
</tr>
<tr>
<td>SQL Server</td>
<td>SQL Server 2008 or above</td>
</tr>
<tr>
<td></td>
<td><strong>Important</strong></td>
</tr>
<tr>
<td></td>
<td>Ensure that the SQL Server is running prior to migration.</td>
</tr>
<tr>
<td>Trend Micro Services</td>
<td>Ensure that the following services are running prior to migration:</td>
</tr>
<tr>
<td></td>
<td>• Trend Micro Control Manager</td>
</tr>
<tr>
<td></td>
<td>• Trend Micro Management Infrastructure</td>
</tr>
</tbody>
</table>
Upgrade and Migration Scenarios

Apex Central supports the following migration scenarios.

- *Scenario 1: Upgrading a Control Manager Server to Apex Central 2019 on page 5-5*
- *Scenario 2: Migrating to a Fresh Apex Central 2019 Installation Using the Agent Migration Tool on page 5-7*

Upgrade Flow

To upgrade a previous version of Control Manager to Apex Central 2019, run the installation program *(Trend Micro Apex Central.exe)* as described in step 1 of *Installing All Required Components on page 3-8*.

---

**Important**

Apex Central 2019 only supports upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3, Control Manager 7.0, or Control Manager 7.0 Patch 1.

---

**Scenario 1: Upgrading a Control Manager Server to Apex Central 2019**

When upgrading a previous version of Control Manager directly to Apex Central 2019, administrators can choose to back up the previous Control Manager installation or back up the entire operating system of the server on which Control Manager installs. Backing up the operating system is more labor intensive but provides better security to prevent data loss.

---

**Important**

Apex Central 2019 only supports upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3, Control Manager 7.0, or Control Manager 7.0 Patch 1.
Upgrading by Backing Up the Previous Control Manager Server and Database

**Important**
Apex Central 2019 only supports upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3, Control Manager 7.0, or Control Manager 7.0 Patch 1.

**Procedure**
1. Back up the previous Control Manager database.
2. Back up all the files under `\Trend Micro\CmKeyBackup\*.*`.
3. Back up all folders of the previous Control Manager server.
4. Back up the registries of the previous Control Manager server.
5. Install Apex Central 2019 over Control Manager.

Upgrading by Backing Up the Entire Operating System of the Server and the Apex Central Database

**Important**
Apex Central 2019 only supports upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3, Control Manager 7.0, or Control Manager 7.0 Patch 1.

**Procedure**
1. Back up the operating system of existing Control Manager server.
2. Back up the existing Control Manager database.
3. Install Apex Central 2019 over Control Manager.
Scenario 2: Migrating to a Fresh Apex Central 2019 Installation Using the Agent Migration Tool

This scenario involves installing Apex Central 2019 on a separate server from the existing Control Manager server. This method allows you to slowly decommission the previous server. See Planning Apex Central Agent Migration on page 5-8 for more information about migrating agents.

Important
Apex Central 2019 only supports upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3, Control Manager 7.0, or Control Manager 7.0 Patch 1.

Migrating a Control Manager Server to a Fresh Installation of Apex Central 2019

Important
Apex Central 2019 only supports upgrading or migrating from Control Manager 6.0 Service Pack 3 Patch 3, Control Manager 7.0, or Control Manager 7.0 Patch 1.

Procedure

1. Back up the existing Control Manager database.

2. Perform a fresh installation of Apex Central 2019 on a different computer.

3. Use the Agent Migration Tool to migrate entities from the Control Manager server to the Apex Central 2019 server.

Note
The Agent Migration Tool only supports migrating managed products and managed product logs. The Agent Migration Tool does not support migrating reports or the Product Directory structure from the previous server.
Planning Apex Central Agent Migration

There are two ways to migrate agents to a Apex Central 2019 server:

- Rapid upgrade
- Phased upgrade

Rapid Upgrade

Rapid upgrade works using the approach presented in the table below.

**TABLE 5-1. Rapid Upgrade**

<table>
<thead>
<tr>
<th>ORIGINAL SERVER/AGENT</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Manager 6.0 Service Pack 3 Patch 3 with MCP agents</td>
<td>Register MCP agents to the Apex Central 2019 server and then re-organize the Product Directory structure</td>
</tr>
<tr>
<td>Control Manager 7.0 with MCP agents</td>
<td></td>
</tr>
<tr>
<td>Control Manager 6.0 Service Pack 3 Patch 3 with mixed agents Control Manager 7.0 with mixed agents</td>
<td>Register MCP agents to the Apex Central 2019 server and then re-organize Product Directory structure</td>
</tr>
</tbody>
</table>

Trend Micro recommends rapid upgrade for migrating agents in a laboratory setting or in relatively small networks, preferably during test deployments (see *Testing Apex Central at One Location on page 2-9*). However, since you cannot stop the migration once it starts, this method works best for smaller deployments. The degree of difficulty increases with the size of the network.
Phased Upgrade

Trend Micro recommends a phased upgrade for large, single-server Control Manager 6.0 Service Pack 3 Patch 3 or 7.0 networks. This is essential for multiple-server networks. This method offers a more structured approach to migrating your system, and follows these guidelines:

- Start migration on systems with the least impact on the existing network, and then proceed to the systems with progressively greater impact
- Upgrade the old network in well-planned stages, rather than all at once

This will simplify any troubleshooting that may be required.

Phased upgrade involves the following steps:

1. Install Apex Central 2019 on a server that does not have any previous Control Manager version installed (preferably without any managed products).
2. Run the AgentMigrateTool.exe tool on the Apex Central 2019 server.

Use the Apex Central agent installation together with the Agent Migration tool to plan the upgrade of agents on existing Apex Central networks. The Agent Migration tool can generate a list of servers with Apex Central agents. Doing so eliminates the need to manually select the agent servers.

Migrating the Apex Central Database

To migrate a preexisting database for Control Manager 6.0 SP3 Patch 3 or 7.0, install Apex Central 2019 on the Control Manager server.

The Apex Central 2019 setup program automatically upgrades the database version.

Migrating a Apex Central SQL Database to Another SQL Server

To move a Apex Central database from an SQL Server to another SQL Server, use the DBConfig tool to perform the migration.
Using the Database Configuration Tool (DBConfig.exe)

The DBConfig.exe tool allows users to change the user account, password, and the database name for the Apex Central database.

The tool offers the following options:

- **DBName**: Database name
- **DBAccount**: Database account
- **DBPassword**: Database password
- **Mode**: Database authentication mode (SQL Server Authentication or Windows Authentication)

**Note**

The default database authentication mode is SQL Server Authentication mode. However, Windows Authentication mode is necessary when configuring for Windows authentication.

**Procedure**

1. Open a command prompt on the Apex Central server.
2. Use the following command to locate the directory which contains the DBConfig.exe file:
   
   ```
   cd <Apex Central installation directory>\DBConfig
   ```
3. Type `dbconfig` and press **ENTER**.
   The DBConfig tool interface appears.
4. Specify which settings you want to modify:
   - Example 1: `DBConfig -DBName="db_your_database>" -DBAccount="sqlAct" -DBPassword="sqlPwd" -Mode="SQL"
   - Example 2: `DBConfig -DBName="db_your_database>" -DBAccount="winAct" -DBPassword="winPwd" -Mode="WA"`
• Example 3: DBConfig -DBName="db_your_database>" -DBPassword="sqlPwd"
Chapter 6

Post-Migration Tasks

Perform the following tasks to verify a successful upgrade or migration, import settings from the Apex One server, or enable and configure additional features.

- *Verifying a Successful Upgrade or Migration on page 6-2*
- *Migrating Apex One Server Settings to Apex Central on page 6-2*
- *Enabling Application Control on page 6-4*
- *Enabling Vulnerability Protection on page 6-5*
- *Enabling Endpoint Sensor on page 6-7*
- *Configuring Apex One Server Settings for Endpoint Sensor on page 6-9*
Verifying a Successful Upgrade or Migration

Perform the following procedure to verify that the previous version of Control Manager successfully upgraded to Apex Central 2019.

Procedure

1. Log on to the Apex Central web console.

The Apex Central web console successfully logs on and the Dashboard appears.

2. Go to Help > About

The About screen appears and displays the Apex Central product name and Version.

3. On the Apex Central server, verify that the following services are running:
   - Trend Micro Apex Central
   - Trend Micro Management Infrastructure

Migrating Apex One Server Settings to Apex Central

Perform the following procedure to migrate existing settings from an existing Apex One server to Apex Central.
Procedure

1. Export settings from the Apex One server.
   a. From the Apex One server, log on to the Apex One web console.
   b. Go to Administration > Settings > Server Migration.
   c. Download the Apex One Settings Export Tool to the Apex One server.
   d. Run the ApexOneSettingsExportTool.exe program to export settings from the Apex One server.
   e. Copy the export package (*.zip file) to a location that is accessible by the Apex Central server.

2. Import the Apex One server settings.
   a. From the Apex Central server, log on to the Apex Central web console.
   b. Go to Policies > Policy Management.
   c. Select Apex One Security Agent as the Product.
   d. Click Import Settings.
   e. Select and upload the *.zip file exported from the Apex One server.
      The screen refreshes and displays the imported policy at the top of the list.
   f. (Optional) Click the policy to edit the settings or perform the following tasks:
      • Enabling Application Control on page 6-4
      • Enabling Vulnerability Protection on page 6-5
      • Enabling Endpoint Sensor on page 6-7
Enabling Application Control

Important

The Application Control feature requires special licensing. Ensure that you have the correct Activation Code before deploying Application Control policies to endpoints. For more information on how to obtain the Activation Code, contact your sales representative.

Procedure

1. Deploy the Activation Code to the managed product servers:
   a. Go to Administration > License Management > Managed Products.
      The License Management screen appears.
   b. Click Add and Deploy.
      The Add and Deploy a New License > Step 1: Input Activation Code screen appears.
   c. Type the Activation Code for the product you want to activate in the New activation code field.
   d. Click Next.
      The Add and Deploy a New License > Step 2: Select Targets screen appears.
   e. Select the target Apex One server(s) to deploy the Activation Code.
   f. Click Deploy.
      The License Management screen appears and the Activated Products column displays the number of managed product servers that have successfully deployed the Activation Code.

2. Go to Policies > Policy Management.
   The Policy Management screen appears.

3. Select Apex One Security Agent as the Product.
4. Specify or edit the **Policy Name**.

5. Specify targets.

6. Create or edit a policy.
   a. To create a policy, click **Create**.
   b. To edit a policy, click a policy name in the **Policy** column.

7. Expand **Application Control Settings**.

8. Select **Enable Application Control**.

9. Click **Deploy** or **Save**.

   The **Policy Management** screen appears and displays the policy deployment status.

   **Note**
   Deployment times vary depending on the size of your network environment. It may take some time to finish deploying the policy to all specified targets.

---

**Enabling Vulnerability Protection**

---

**Important**
The Vulnerability Protection feature requires special licensing. Ensure that you have the correct Activation Code before deploying Vulnerability Protection policies to endpoints. For more information on how to obtain the Activation Code, contact your sales representative.

---

**Procedure**

1. Deploy the Activation Code to the managed product servers:
   a. Go to **Administration > License Management > Managed Products**.
      
      The **License Management** screen appears.
b. Click **Add and Deploy**.

The **Add and Deploy a New License > Step 1: Input Activation Code** screen appears.

c. Type the Activation Code for the product you want to activate in the **New activation code** field.

d. Click **Next**.

The **Add and Deploy a New License > Step 2: Select Targets** screen appears.

e. Select the target Apex One server(s) to deploy the Activation Code.

f. Click **Deploy**.

The **License Management** screen appears and the **Activated Products** column displays the number of managed product servers that have successfully deployed the Activation Code.

2. Go to **Policies > Policy Management**.

The **Policy Management** screen appears.

3. Select **Apex One Security Agent** as the **Product**.

4. Specify or edit the **Policy Name**.

5. Specify targets.

6. Create or edit a policy.

   a. To create a policy, click **Create**.

   b. To edit a policy, click a policy name in the **Policy** column.

7. Expand **Vulnerability Protection Settings**.

8. Select **Enable Vulnerability Protection**.

9. Click **Deploy** or **Save**.

The **Policy Management** screen appears and displays the policy deployment status.
**Note**

Deployment times vary depending on the size of your network environment. It may take some time to finish deploying the policy to all specified targets.

---

### Enabling Endpoint Sensor

**Important**

- The Endpoint Sensor feature requires special licensing and additional system requirements. Ensure that you have the correct license before deploying Endpoint Sensor policies to endpoints. For more information on how to obtain licenses, contact your support provider.

- Connected Apex One servers require additional hardware and software requirements for the Endpoint Sensor feature to work. For more information, refer to the Apex One Installation and Upgrade Guide.

---

**Procedure**

1. **Deploy the Activation Code to the managed product servers:**
   
   a. Go to Administration > License Management > Managed Products. The License Management screen appears.

   b. Click Add and Deploy.

   The Add and Deploy a New License > Step 1: Input Activation Code screen appears.

   c. Type the Activation Code for the product you want to activate in the New activation code field.

   d. Click Next.

   The Add and Deploy a New License > Step 2: Select Targets screen appears.
e. Select the target Apex One server(s) or Apex One (Mac) servers to deploy the Activation Code.

f. Click **Deploy**.

   The **License Management** screen appears and the **Activated Products** column displays the number of managed product servers that have successfully deployed the Activation Code.

2. Go to **Policies > Policy Management**.

   The **Policy Management** screen appears.

3. Select **Apex One Security Agent** as the **Product**.

4. Specify or edit the **Policy Name**.

5. Specify targets.

6. Create or edit a policy.

   a. To create a policy, click **Create**.

   b. To edit a policy, click a policy name in the **Policy** column.

7. Expand **Endpoint Sensor Settings**.

8. Select **Enable Endpoint Sensor**.

9. Click **Deploy** or **Save**.

   The **Policy Management** screen appears and displays the policy deployment status.

---

**Note**

Deployment times vary depending on the size of your network environment. It may take some time to finish deploying the policy to all specified targets.
Configuring Apex One Server Settings for Endpoint Sensor

**Important**

- The Endpoint Sensor feature requires special licensing and additional system requirements. Ensure that you have the correct license before deploying Endpoint Sensor policies to endpoints. For more information on how to obtain licenses, contact your support provider.

- Connected Apex One servers require additional hardware and software requirements for the Endpoint Sensor feature to work. For more information, refer to the Apex One Installation and Upgrade Guide.

- The following procedure assumes you have already enabled Endpoint Sensor by creating or editing an Apex One Security Agent policy.

  For more information, see *Enabling Endpoint Sensor on page 6-7*.

**Procedure**

1. Go to **Policies > Policy Management**.
   The **Policy Management** screen appears.

2. Select **Apex One Server** as the **Product**.

3. Specify or edit the **Policy Name**.

4. Specify targets.

5. Create or edit a policy.
   a. To create a policy, click **Create**.
   b. To edit a policy, click a policy name in the **Policy** column.

6. Expand **Endpoint Sensor** to configure the following settings:
### Option | Description
--- | ---
Maximum metadata storage | Specify the maximum size allowed for metadata storage. Specify a size between 1024 to 4096 GB. The default storage size is 1024 GB. Once the metadata storage reaches this size, the server purges old records to accommodate new ones.

Maximum memory allocation | Specify the maximum amount of memory allocated to the metadata cache. Specify a size between 4 GB and 64 GB. The new size specified must be higher than the current size. The default allocation size is 4 GB.

*Note*

Memory size affects the performance of data uploads and investigation speed. To improve performance, increase the memory size of the affected server.

7. Click **Deploy** or **Save**.

The **Policy Management** screen appears and displays the policy deployment status.

*Note*

Deployment times vary depending on the size of your network environment. It may take some time to finish deploying the policy to all specified targets.
Uninstallation

This chapter contains information about how to uninstall Apex Central and remove related files.

Topics include:

• Removing Apex Central on page 7-2
• Manually Removing Apex Central on page 7-3
Removing Apex Central

Uninstall Apex Central from the server by using one of the following methods:

Procedure

• From the Start menu, click Start > Trend Micro Apex Central > Uninstalling Trend Micro Apex Central.

• Using Add/Remove Programs:
  a. Go to Start > Control Panel > Add/Remove Programs.
  b. Select Trend Micro Apex Central and click Uninstall.
     A confirmation dialog appears.
  c. Click Yes to uninstall Apex Central.
  d. Choose whether to uninstall the Apex Central database:

    Note
    Keeping the database allows you to reinstall Apex Central on the server and retain all system information, such as agent registration and user account data.

    • To uninstall the database, select the Remove Apex Central database check box.
    • To keep the database, do not select the Remove Apex Central database check box.

  e. Click Next.
   • The uninstallation program removes Apex Central from the server.
   • If you selected Remove the Apex Central database, the uninstallation program also removes the database.
   • If you reinstall the Apex Central server without deleting the original database and removing the managed products that originally reported to
the previous server, then the managed products will re-register to the Apex Central server when:

- Managed product servers restart MCP agent services
- MCP agents verify their connection after an 8-hour period

---

#### Manually Removing Apex Central

This section describes how to remove Apex Central manually. Use the procedures below only if the Windows Add/Remove function or the Apex Central uninstall program is unsuccessful.

---

**Note**

Windows-specific instructions may vary between operating system versions. The following procedures are written for Windows Server 2012.

---

Removing Apex Central actually involves removing distinct components. These components may be removed in any order; they may even be removed together. However, for purposes of clarity, the uninstallation for each module is discussed individually, in separate sections. The components are:

- Apex Central application
- Apex Central Database (optional)

---

**Note**

After removing all components, you must restart your server. You only have to do this once — after completing the removal.

---

#### Removing the Apex Central Application

Manual removal of the Apex Central application involves the following steps:
1. **Stopping Apex Central Services on page 7-4**
2. **Removing Apex Central IIS Settings on page 7-5**
3. **Deleting Apex Central Files/Directories and Registry Keys on page 7-6**
4. **Removing the Database Components on page 7-7**
5. **Removing the Apex Central Service on page 7-8**

### Stopping Apex Central Services

Use the **Windows Services** screen to stop all of the following Apex Central services:

- Trend Micro Apex Central

---

**Note**

These services run in the background on the Windows operating system, not the Trend Micro services that require Activation Codes (for example, Outbreak Prevention Services).

---

### Stopping Apex Central Services from the Windows Services Screen

**Procedure**

1. Click **Start > Programs > Administrative Tools > Services** to open the **Services** screen.
2. Right-click **Trend Micro Apex Central** and then click **Stop**.

---

### Stopping IIS and Apex Central Services from the Command Prompt

**Procedure**

- Run the following commands at the command prompt:
Uninstallation

`net stop w3svc`
`net stop tmcm`

---

**Figure 7-1. View of the command line with the necessary services stopped**

---

**Removing Apex Central IIS Settings**

Remove the Internet Information Services settings after stopping the Apex Central services.

**Procedure**

1. From the Apex Central server, click **Start > Run**.
   
   The **Run** dialog box appears.

2. Type the following in the **Open** field:

   `%SystemRoot%\System32\Inetsrv\iis.msc`

3. On the left-hand menu, double-click the server name to expand the console tree.

4. Double-click **Default Web Site**.
5. Delete the following virtual directories:
   - ControlManager
   - TVCSDownload
   - TVCS
   - WebApp

6. Select the **ISAPI Filters** tab.

7. Delete the following ISAPI filters:
   - TmcmRedirect
   - ReverseProxy

---

**Deleting Apex Central Files/Directories and Registry Keys**

**Procedure**

1. Delete the following directories:
   - .Trend Micro\Control Manager
   - .Trend Micro\COMMON\ccgi
   - .PHP
   - C:\Documents and Settings\All Users\Start Menu\Programs \PHP 7
   - C:\Documents and Settings\All Users\Start Menu\Programs \Trend Micro Apex Central

2. Delete the following Apex Central registry keys:
   - HKEY_LOCAL_MACHINE\SOFTWARE\TrendMicro\MCPAgent
   - HKEY_LOCAL_MACHINE\SOFTWARE\TrendMicro\OPPTrustPort
Removing the Database Components

This section describes how to remove the following database components from the Apex Central server:

- Removing Apex Central ODBC Settings on page 7-7
- Removing the SQL Server 2017 Express Database on page 7-8

Removing Apex Central ODBC Settings

Procedure

1. On the Apex Central server, click **Start > Run**.
   
   The **Run** dialog box appears.

2. Type the following in the **Open** field:
   
   odbcad32.exe

3. On the **ODBC Data Source Administrator** screen, click the **System DSN** tab.

4. Under **Name**, select **ControlManager_Database**.

5. Click **Remove**, and then click **Yes** to confirm.
Removing the SQL Server 2017 Express Database

Procedure

1. On the Apex Central server, click **Start > Control Panel > Add/Remove Programs**.

2. Scroll down to **SQL Server 2017** and then click **Remove** to remove the related files automatically.

   **Tip**
   
   For more information on removing SQL Server 2017 Express, refer to the Microsoft documentation.

Removing the Apex Central Service

Procedure

1. Run the Microsoft service tool **Sc.exe**.

2. Type the following command:

   ```
   sc delete "TMCM"
   ```
Chapter 8

Apex Central System Checklists

Use the checklists in this section to record relevant system information as a reference.

Topics include:

• Server Address Checklist on page 8-2
• Port Checklist on page 8-3
• Apex Central Conventions on page 8-3
• Core Processes and Configuration Files on page 8-4
• Communication and Listening Ports on page 8-6
Server Address Checklist

You must provide the following server address information during the installation process, as well as during the configuration of the Apex Central server to work with your network. Record the information here for easy reference.

**TABLE 8-1. Server Address Checklist**

<table>
<thead>
<tr>
<th>INFORMATION REQUIRED</th>
<th>EXAMPLE</th>
<th>YOUR VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apex Central server information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address</td>
<td>10.1.104.255</td>
<td></td>
</tr>
<tr>
<td>Fully qualified domain name (FQDN)</td>
<td>server.company.com</td>
<td></td>
</tr>
<tr>
<td>NetBIOS (host) name</td>
<td>yourserver</td>
<td></td>
</tr>
<tr>
<td><strong>Web server information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address</td>
<td>10.1.104.225</td>
<td></td>
</tr>
<tr>
<td>Fully qualified domain name (FQDN)</td>
<td>server.company.com</td>
<td></td>
</tr>
<tr>
<td>NetBIOS (host) name</td>
<td>yourserver</td>
<td></td>
</tr>
<tr>
<td><strong>SQL-based Apex Central database information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address</td>
<td>10.1.104.225</td>
<td></td>
</tr>
<tr>
<td>Fully qualified domain name (FQDN)</td>
<td>server.company.com</td>
<td></td>
</tr>
<tr>
<td>NetBIOS (host) name</td>
<td>sqlserver</td>
<td></td>
</tr>
<tr>
<td><strong>Proxy server for component download</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address</td>
<td>10.1.174.225</td>
<td></td>
</tr>
<tr>
<td>Fully qualified domain name (FQDN)</td>
<td>proxy.company.com</td>
<td></td>
</tr>
<tr>
<td>NetBIOS (host) name</td>
<td>proxyserver</td>
<td></td>
</tr>
</tbody>
</table>
### Information Required

<table>
<thead>
<tr>
<th>Information Required</th>
<th>Example</th>
<th>Your Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP server information (Optional; for email message notifications)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address</td>
<td>10.1.123.225</td>
<td></td>
</tr>
<tr>
<td>Fully qualified domain name (FQDN)</td>
<td>mail.company.com</td>
<td></td>
</tr>
<tr>
<td>NetBIOS (host) name</td>
<td>mailserver</td>
<td></td>
</tr>
<tr>
<td>SNMP Trap information (Optional; for SNMP Trap notifications)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Community name</td>
<td>trendmicro</td>
<td></td>
</tr>
<tr>
<td>IP address</td>
<td>10.1.194.225</td>
<td></td>
</tr>
<tr>
<td>Syslog server information (Optional; for syslog notifications)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP address</td>
<td>10.1.194.225</td>
<td></td>
</tr>
<tr>
<td>Server port</td>
<td>514</td>
<td></td>
</tr>
</tbody>
</table>

### Port Checklist

Apex Central uses the following ports for the indicated purposes.

<table>
<thead>
<tr>
<th>Port</th>
<th>Sample</th>
<th>Your Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Proxy</td>
<td>8088</td>
<td></td>
</tr>
<tr>
<td>Web Console and Update/Deploy components</td>
<td>80</td>
<td></td>
</tr>
</tbody>
</table>

### Apex Central Conventions

Refer to the following conventions applicable for the Apex Central installation or web console configuration.
• User names
  • Max. length: 32 characters
  • Allowed: \texttt{A-Z, a-z, 0-9, -, ., $}

• Folder names
  • Max. length: 32 characters
  • Not allowed: /, >, <, ", %, ^, =

\textbf{Note}

For the Apex Central server host name, the setup program supports servers with underscores ("_") as part of the server name.

\section*{Core Processes and Configuration Files}

Apex Central saves system configuration settings and temporary files in XML format.

The following tables describe the configuration files and processes used by Apex Central.

\textbf{TABLE 8-2. Apex Central Configuration Files}

<table>
<thead>
<tr>
<th>Configuration File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AuthInfo.ini</td>
<td>Configuration file that contains information about private key file names, public key file names, certificate file names, and the encrypted passphrase of the private key as well as the host ID and port.</td>
</tr>
<tr>
<td>aucfg.ini</td>
<td>ActiveUpdate configuration file</td>
</tr>
<tr>
<td>TVCS_Cert.pem</td>
<td>Certificate used by SSL authentication</td>
</tr>
<tr>
<td>TVCS_Pri.pem</td>
<td>Private Key used by SSL</td>
</tr>
<tr>
<td>TVCS_Pub.pem</td>
<td>Public Key used by SSL</td>
</tr>
</tbody>
</table>
### Configuration File

<table>
<thead>
<tr>
<th>Configuration File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessManager.xml</td>
<td>Used by ProcessManager.exe</td>
</tr>
<tr>
<td>CmdProcessorEventHandler.xml</td>
<td>Used by CmdProcessor.exe</td>
</tr>
<tr>
<td>DMRegisterinfo.xml</td>
<td>Used by CasProcessor.exe</td>
</tr>
<tr>
<td>DataSource.xml</td>
<td>Stores the connection parameters for Apex Central processes</td>
</tr>
<tr>
<td>SystemConfiguration.xml</td>
<td>Apex Central system configuration file</td>
</tr>
<tr>
<td>agent.ini</td>
<td>MCP agent file</td>
</tr>
</tbody>
</table>

### Table 8-3. Apex Central Core Processes

<table>
<thead>
<tr>
<th>Processes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessManager.exe</td>
<td>Launches and stops other Apex Central core processes</td>
</tr>
<tr>
<td>CmdProcessor.exe</td>
<td>Sends XML instructions, formed by other processes, to managed products, processes product registration, sends alerts, performs scheduled tasks, and applies Outbreak Prevention Policies</td>
</tr>
<tr>
<td>LogReceiver.exe</td>
<td>Receives managed product logs and messages. Starting with Control Manager 3.0 Service Pack 4, LogReceiver.exe only handles logs coming from Trend Micro Damage Control Services and Trend Micro Vulnerability Assessment</td>
</tr>
<tr>
<td>LogProcessor.exe</td>
<td>Receives logs from managed products, and receives entity information from managed products</td>
</tr>
<tr>
<td>LogRetriever.exe</td>
<td>Retrieves and saves logs in the Apex Central database</td>
</tr>
<tr>
<td>ReportServer.exe</td>
<td>Generates Apex Central reports</td>
</tr>
<tr>
<td>MsgReceiver.exe</td>
<td>Receives messages from the Apex Central server and managed products</td>
</tr>
</tbody>
</table>
### Processes

<table>
<thead>
<tr>
<th>Processes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CasProcessor.exe</td>
<td>Allows a Apex Central server to manage other Apex Central servers</td>
</tr>
<tr>
<td>inetinfo.exe</td>
<td>Microsoft Internet Information Service process</td>
</tr>
<tr>
<td>cm.exe</td>
<td>Manages dmserver.exe and mrf.exe</td>
</tr>
<tr>
<td>dmserver.exe</td>
<td>Provides the Apex Central web console log on page and manages the Product Directory (Apex Central-side)</td>
</tr>
<tr>
<td>sCloudProcessor.NET.exe</td>
<td>Requests the Apex Central web console or other processes to provide a job ID for the issuer to query statuses, query results, and cancel requests; used by the User/Endpoint Directory</td>
</tr>
</tbody>
</table>

### Communication and Listening Ports

These are the default Apex Central communication and listening ports.

<table>
<thead>
<tr>
<th>Service</th>
<th>Service Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessManager.exe</td>
<td>20501</td>
</tr>
<tr>
<td>CmdProcessor.exe</td>
<td>20101</td>
</tr>
<tr>
<td>cmdProcessor.NET.exe</td>
<td>21003</td>
</tr>
<tr>
<td>LogReceiver.exe</td>
<td>20201</td>
</tr>
<tr>
<td>LogProcessor.exe</td>
<td>21001</td>
</tr>
<tr>
<td>LogRetriever.exe</td>
<td>20301</td>
</tr>
<tr>
<td>ReportServer.exe</td>
<td>20601</td>
</tr>
<tr>
<td>MsgReceiver.exe</td>
<td>20001</td>
</tr>
<tr>
<td>CasProcessor.exe</td>
<td>20801</td>
</tr>
<tr>
<td>sCloudProcessor.NET.exe</td>
<td>21002</td>
</tr>
</tbody>
</table>
Index

A
activating
  Apex Central, 4-4, 4-5
Activation Code, 4-4
Active Directory
  connection settings, 4-6
  manual synchronization, 4-6
  synchronization frequency, 4-6
Apex Central, 1-1, 1-2, 1-5
  about, 1-1, 1-2
  activating, 4-4, 4-5
  command prompt, stopping service from, 7-4
  installation steps, 3-7
  installing, 3-1, 3-6, 3-7
  license information, 4-5
  mail server, 1-5
  manually removing, 7-3
  MCP, 1-5
  removing manually, 7-3
  report server, 1-5
  SQL database, 1-5
  system requirements, 3-2
  web-based management console, 1-6
  web server, 1-5
  web service integration, 1-5
  widget framework, 1-6

B
backing up Apex Central, 5-3

C
checklist
  ports, 8-3
  server address, 8-2

command polling
  MCP, 2-17

command prompt
  Apex Central, stopping service from, 7-4

configuring
  user accounts, 4-9
  web server, 2-21

Control Manager
  migrating database, 5-9
  security levels, 3-14
  testing pilot deployment, 2-9

converting
  full version, 4-5

D
database
  recommendations, 2-19

data storage
  plan, 2-19

DBConfig tool, 5-10

deployment
  architecture and strategy, 2-2
  multiple-site, 2-4
  single-site, 2-3

documentation, vi

F
full version
  converting, 4-5

H
heartbeat, 2-14
  MCP, 2-17
I
installation
  flow, 2-9
  verify success, 4-2
installation steps
  Apex Central, 3-7
installing
  Apex Central, 3-1, 3-7
  steps, 3-7

L
license information, 4-5
logs
  traffic, 2-15

M
manually
  removing Apex Central, 7-3
manually uninstalling, 7-3
MCP, 1-5
  command polling, 2-17
  heartbeat, 2-17
  policies, 2-16
migrating, 5-8
  Control Manager SQL 2000, 5-9
database, 5-9
phased upgrade, 5-9
rapid upgrade, 5-8
strategy, 5-8
multiple-site deployment
  understanding, 2-4

N
network traffic
  sources, 2-15
network traffic plan, 2-13

O
ODBC
  settings, Control Manager, 7-7

P
phased upgrade, 5-9
pilot deployment
testing, 2-9
policies
  MCP, 2-16
port
  checklist, 8-3
product registration
  traffic, 2-17

R
rapid upgrade, 5-8
recommendations
  database, 2-19
Registration Key, 4-5
remove
  manual
    Microsoft Data Engine, 7-7
removing
  Apex Central manually, 7-3
  manual
    Apex Central, 7-3

S
server
  address checklist, 8-2
server address checklist, 8-2
server distribution plan, 2-11
single-site deployment
  understanding, 2-3
system requirements, 3-2
T
terminology, viii
tools
  DBConfig tool, 5-10
traffic, network, 2-13

U
understanding
  multiple-site deployment, 2-4
  single-site deployment, 2-3
updates
  deploying, 2-18
upgrading, 5-2
  backing up Apex Central information, 5-3
user accounts
  configuring, 4-9

V
verify successful installation, 4-2

W
web server
  configuration, 2-21
  plan, 2-21
web server settings, 3-13
Windows Server 2012, 3-3
Windows Server 2012 R2, 3-3
Windows Server 2016, 3-4
Windows Server 2019, 3-5